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Screening Crystals on the XtaLAB MM003 XRD System 

 Before you can access the X-Ray lab you must complete the X-Ray safety training with EH&S. 
Please forward Annette your certificate for documentation. 

 Neither EH&S X-ray safety training nor this protocol does replace the one-on-one training with 
Annette Erbse. You must receive training from Annette and be approved to run the XtaLAB 
MM003  Source, before you can do experiments independently. 

 This assumes that you have been trained in mounting crystals. 

 

Several Days Before You Want To Screen Xtals 

1. Please let Annette Erbse know that you are planning to screen Xtals and sign up for time on the 

XtaLAB MM003 on the Google calendar. 

2. If the system has not been used in a long time everything will be switched off. You will have to 

do a few things to get the instrument ready and it will take at least 24 hr. 

Two Days Before You Want To Screen Xtals 

1. This is the latest time to let Annette know that you want to run the XtaLAB MM003 and to sign 

up for time in the Google calendar. 

2. Check if there is enough liquid N2 in the tank. If you will be collecting data for a day it should be 

at least 1/3 full.  If not contact Annette. 
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24 Hours Before You Want To Screen Xtals  

1. Switch on heat exchanger 

 
 

2. Switch on the dry air generator 

 
3. Check that the flow to the CCD detector is at 50 to 80 

 

4. Start up the X-rays source:  Click the SpellmanXgControl icon. Choose the default (longer than 8 

weeks off) option and click power ON. This will slowly power the source up.  

Once the X-Rays are started it should look like this:  
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Start Up on the Day you screen Xtal 

1. Make sure the Dewar is filled to at least 30%. 

2. Turn on the cryo stream (easy three step instructions are posted next to the controller) and cool 

it down to 100 K. This will take about 20 min.  

 

3. Turn on the Pilatus 200 detector. All LEDs should turn green. This might take a few minutes.  
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4. Click on the HKL-3000R P200SK Chi icon to start HKL-3000 for data collection. (Do not start HKL-

300R, this is only for data analysis and has no collection functions.)  

 

5. The program interface and a Terminal Window will open. Do not close the Terminal Window. 

You can minimize it, if it is in your way.  

6. You will be in the Data tab of HKL-3000.  

7. Switch to the Collect Tab.  
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8. Click Connect to establish a connection between the computer, the goniometer and the 

detector. Do not close the new terminal window. Minimize it, if it is in the way. The program will 

make contact to the instrument and will go through some testing while moving the detector and 

the goniometer. Therefore it is important that nothing is on the table around the instrument 

that could lead to collisions. 

9. A Shutter Status window will open. You cannot close or minimize the Shutter Status window. 

Move it to the edge of the screen if it is in the way. It is important that you keep an eye on the 

Shutter Status. 

10. In the Manual tab inside the Collect tab you can control the goniometer, e.g. swing the chi arm 

away, and move the detector out for easy access or to get a good contrast for the camera for 

crystal mounting. 

11. Set the distance to 200 and 2Theta to – 20. Click move. 

12. It is assumed here that you received training from Annette Erbse and as a result you know how 

to mount a crystal and align it. 

13. Once your crystal is mounted you can go to the Align tab to measure it and to take a picture. You 

figure out how the controls work, it’s easy. 
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14. Go back to the Data Tab. 

15. Create a new directory for yourself by clicking Create Directory and type in a new name in the 

pop-up window.
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16. Repeat the process and make a folder for today inside your new directory. Avoid spaces and 

special characters in the name. Set the new directory as New Raw Data Dir and New Output 

Data Dir 

17. Go to the Project Tab and set up a new project by clicking “New Project”. Give the 

project a name and name the crystal. For screening you can simply keep adding crystals 

to the project. I usually just count them through XYZ a, b, c … You can load in a 

sequence, but it is only needed if you want to actually solve a structure in HKL 3000 and 

can always be done at a later time point. The screen shot shows what it would look like 

for planned Lysozyme with Sulfur as anomalous signal for phasing. 
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Setting Up Collection 

1. Go to the Collect Tab and select Collect to set up data collection for screening.  At this point it 

should automatically come up with Crystal Check selected. 

2. Choose a data directory by clicking into the box next to Base Directory. Choose the directory in the 

pop up window. 

3.  Choose a data collection strategy. What is shown below might be a good starting point. 

4. If the space group is known choose the longest side/2 for distance eg. For Lysozyme 80/2= 40. 

 

5. Select “2 Frames w/Step". If you want 900 step, Omega Start has to be -10. 

Note: To get a good idea about mosaicity you might want to collect more frames. This is not 

necessary for basic screening but is a good thing to do to characterize a crystal that you like a 

little more and to be able to compare the effect of different crystallization conditions.  

See Collecting and Indexing a Small Sequence of Frames 
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6. Go back into the enclosure and put the beam stop on! 

7. Take the cover carefully off the detector. 

8. Go out of the enclosure, close the doors and lock them. 

9. Click Collect Set. 

10. dTREK should open and display collected images. You can scroll using the wheel on the mouse to 

zoom in and out. Change contrast by going to “edit” “image view properties” and changing black and 

white pixels. 

 

11. If you want to get a quick idea about resolution perform steps 1 to 3 from the next section on the 

collected frame. This is to make sure that HKL reads in the direct beam position correctly.   

12. If you don’t see spots or only a few consider trying different positions on the crystal. There might still 

be something there. 

 

 Indexing  

1. Go to Data Tab. If you have just collected data the data will be pending. Select the set that you want 

to use for indexing.  
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2. Go to the Index Tab and choose the set you want to work with. 

3. Click Peak Search. A new window will come up with the peaks marked. The red circles indicate 

identified peaks. There should be at least 100. If you can't see the number click Edit P.S. If very few 

peaks have been found, you can increase that number by hitting Edit P.S. and then More peaks in 

the panel on the right. Confirm with OK.  
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4. The zoom window will allow you a closer look. 
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5. Click Index in the main window.   

6. A window will come up with possible Bravais lattices. 

 

7. Choose the lattice that you know is correct. If you don't know, stay with the triclinic space group to 

start with. 

8. Click refine several times until X/Y/Z rotations converge. 

9. In the Viewer Window the yellow circles indicate predicted spots. Red circles indicate overlaps and 

are bad. 
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10. Go back to the Bravais lattice window and select the next good space group. Work your way up to 

the one that has the highest symmetry but still small distortions/errors. (color coded, green is go) 

by clicking Apply and Close and refining again. 

11. In the viewer window alternate between “remove pred.” and “update pred.” to check that the 

spots line up. 

12. Click Fit All and Refine 

13. Make sure Mosaicity and Distance are selected, click Fit All and Refine 

14. Click Refine several times until data converge. 

15. This should give you a very first idea about your crystal. If you have one you like and you want to get 

a better idea about mosaicity or if you want to collect real data on our source you should do one 

more Crystal Check but collect a few more frames in sequence. 

Collecting and Indexing a Small Sequence of Frames 

1. The procedure is similar to before with the following changes: 
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2. In the Collect Tab, uncheck 2 frames w/step, set # of frames to 6 (or whatever you would like), 

Omega Start to 0 (or whatever Omega gave you a promising frame before), Frame Width to 0.25 

or 0.5. 

3. Click Collect Sequence. 

 

 

4. Go to Index in the Index Tab type in number of frames (e.g. 6) in 3D Window. 

5. Click Peak Search 

6. To cycle through the frames, middle click the Frame button on the top left of the image window. The 

first time you do that, you'll have to hit Peak Search on the top right to identify peaks in the new 
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frame, but after that, the software knows what you're trying to do. 

7.  When you've clicked through all frames, confirm by clicking OK, then click Index in the main 

window. 

8. In the zoom window click Int box. 

 

9. Predictions are indicated by circles. Red means overlap and is bad. Yellow is good. The integration 

boundary is defined by the inner ragged circumference. The big square minus the outer 

circumference defines the background. 

10. In the Integration Box of the Index Tab make Spot and Background Radius the same size and click 

Refine to apply. 

11. Box size:  A good box size should enclose the whole spot. Changing box size between even and odd 

numbers will change the form of the box, which might help eliminate overlap. Don't forget to click 

Refine to apply. 

12. Profile Fitting Radius: The circle you see if you move the mouse into the image window is the 

current circle profile fitting radius.  It should always have at least 9 spots/predictions inside. If that 

should not be the case increase the radius. But in most cases the suggested value is fine. 

13. Finally click Fit All again and do a few rounds of Refine. The residuals should come close to zero and 

the predictions should be on top of spots. 

14. You now have a good first idea about space group and mosaicity. 

15. If you want to use this to design a collection strategy click Keep Current Values For All Sets and go to 
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the Strategy tab. 

 

Final notes: 

1. It is always a good idea to try several different positions of the crystal while screening.  

2. Once you have a strategy designed with help of the Strategy Tab it is also a good idea to try a 

few frames for every segment of the strategy to make sure that the crystal is not rotated out of 

the beam. 

3. Consider to collect a smaller wedge of the Strategy first and analyze the data quality. There is no 

point in running a 5 day strategy just to see in the end that the data quality is not sufficient. You 

do not have to stop data collection while you do that. 

 

Shutting the XtaLAB MM003  down 

1. If you are completely done with screening crystals and data collection and nobody is signed up 

for data collection on the XtaLAB MM003  system in the next 2 days you can shut down the X-

ray generator. 

2. Please let Annette Erbse know that you have finished your experiment and that you will shut 

down the system. 

3. Open the “SpellmanXgControl" and click power “OFF”. 

4. The yellow light next to the tube tower should go off and the "High Voltage Status Button" 

should go to "OFF". 
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5. The X-ray power reading should go to around 0.1 kV and 0.001 mA. 

6. Switch off the cryo-stream and the dry air (instructions posted next to the components and on 

the website of the X-ray facility).  

7. Switch off the detector and the monitor for the Xtals. 

8. Switch off the heat exchanger. 
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